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Inleiding op de TI Connect™ CE-software

De TI Connect™ CE-software maakt het uitwisselen van informatie tussen uw
grafische rekenmachine en uw computer snel en makkelijk.

De software ondersteunt alle grafische rekenmachines van de TI-8x-serie met
een USB-poort, waaronder:

• TI-84 Plus CE

• TI-84 Plus CE-T

• TI 84 Plus C Silver Edition

• TI-84 Plus

• TI-83 Premium CE

• TI-83 Plus.fr

• TI-82 Advanced

Opmerking: Gebruik TI Connect 4.0 software die rekenmachines ondersteunt
die alleen over een I/O-poort beschikken:

• TI-83 Plus

• TI-89

• Voyage 200

• TI-73 Explorer

Inleiding op de TI Connect™ CE-software 1



2 Het venster van de TI Connect™ CE-software gebruiken

Het venster van de TI Connect™ CE-software
gebruiken

Het venster van de TI Connect™ CE-software bevat tools die u kunt gebruiken
om informatie uit te wisselen tussen uw rekenmachine en uw computer.

De TI Connect™ CE-software bevat drie werkruimtes:

• Screen Capture (Schermvastlegging): hiermee kunt u
schermvastleggingen beheren

• Calculator Explorer (Rekenmachineverkenner): hiermee kunt u inhoud van
rekenmachines beheren

• Program Editor (Programmabewerker): hiermee kunt u werken met
gegevensvariabelen



Gedeeltes van het venster van de TI Connect™ CE-
software

Menubalk - Gebruik deze menu's om rekenmachinebestanden en -
schermen te beheren, informatie over de rekenmachine te bekijken en
om hulp te krijgen.

Werkbalk - Gebruik deze pictogrammen om computerbestanden en -
schermen te beheren.

Werkruimtepaneel - Gebruik dit paneel om werkruimtes te selecteren
(Calculator Explorer, Screen Capture en Program Editor).
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4 Het venster van de TI Connect™ CE-software gebruiken

Paneel Lijst met rekenmachines - Gebruik deze lijst om alle
aangesloten rekenmachines te bekijken en om één rekenmachine te
selecteren voor weergave.

Inhoudspaneel - Gebruik dit paneel om de rekenmachinebestanden
en -schermen op aangesloten rekenmachine(s) te bekijken en te
beheren.

Opmerking: u kunt de meeste van de acties in deze menu's uitvoeren
door items te verslepen en neer te zetten op uw aangesloten
rekenmachine of computer.



De werkruimte Screen Capture gebruiken

Met de werkruimte Screen Capture kunt u schermvastleggingen van
rekenmachines beheren.
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6 De werkruimte Screen Capture gebruiken

Onderdelen van het venster Screen Capture

Menubalk - Gebruik deze menu's om bestanden en afbeeldingen te beheren,
informatie over de rekenmachine te bekijken en om hulp te krijgen.

Opmerking: u kunt de meeste van de acties in deze menu's uitvoeren door
items van het Inhoudspaneel te verslepen en neer te zetten.

Werkbalk - Klik op deze pictogrammen om bestanden op te slaan, te
verzenden, te kopiëren, te verwijderen en de afmetingen ervan te veranderen.

Een bestand op de computer opslaan.

Een bestand verzenden naar een rekenmachine.

Een bestand kopiëren.

Een bestand wissen.

Een rand toevoegen aan of verwijderen van alle vastgelegde schermen.

De afmetingen van alle vastgelegde schermen veranderen.

De afmetingen van de schermvastlegging bekijken.

Inhoudspaneel - Schermvastleggingen bekijken in het Inhoudspaneel.



Schermen vastleggen en gebruiken

In de werkruimte Screen Capture kunt u schermen van uw rekenmachine
vastleggen en bekijken.

Voordat u begint
Sluit de rekenmachine aan op de computer en controleer of deze verschijnt in
het Rekenmachinepaneel.

Rekenmachineschermen vastleggen
1. Klik op het TI Connect™ paneel Werkruimte van de CE-software op de

werkruimte Screen Capture.

2. Geef het scherm weer op uw rekenmachine dat u wilt vastleggen.

3. Klik op naast de gewenste rekenmachine in het paneel met de lijst
met rekenmachines.

• Als er meer dan één rekenmachine aangesloten is, klik dan op
CONNECTED CALCULATORS om schermen van alle rekenmachines
vast te leggen.

Rekenmachineschermen opslaan als bestanden

Met de werkruimte Screen Capture kunt u vastgelegde of bestaande
afbeeldingen van uw rekenmachine opslaan als PNG-bestanden.

Opmerking: het sterretje aan het begin van de naam van een afbeelding geeft
aan dat de afbeelding niet is opgeslagen.

Een bestaand scherm opslaan
1. Klik op het vastgelegde scherm in het paneel Content (Inhoud).

2. Klik op .
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8 De werkruimte Screen Capture gebruiken

Meerdere schermen opslaan
1. Klik op Edit > Select All (Bewerken > Alles selecteren).

2. Klik op .

Een schermvastlegging een andere naam geven
1. Plaats de cursor aan het begin van het veld met de schermnaam.

Bv.: Capture 1.

2. Dubbelklik op de naam om deze te selecteren.

3. Typ een nieuwe naam in voor het computerbestand.

Een nieuwe schermvastlegging opslaan als PNG-bestand
1. Klik op de afbeelding.

2. Klik op .

3. Navigeer naar de gewenste locatie voor opslag.

4. Gebruik de standaard bestandsnaam of typ een nieuwe bestandsnaam in.

5. Klik op .

Schermvastleggingen naar aangesloten rekenmachines verzenden
De functie Screen Capture Only biedt een manier om een scherm met een
grafiek op rekenmachines met een hoge resolutie vast te leggen, het
grafiekgebied bij te snijden en vervolgens alleen het grafiekgebied te
converteren naar een achtergrondafbeelding. Vink Graph Area Only (Alleen
grafiekgebied) aan om dit type achtergrondafbeelding te creëren.

1. Leg het scherm vast als u dit nog niet gedaan heeft.

2. Klik op de schermvastlegging om deze te selecteren.

3. Klik op



• FILE NAME (BESTANDSNAAM): Deze kan anders zijn dan de NAME ON
CALCULATOR (NAAM OP REKENMACHINE), afhankelijk van welke naam
u de schermvastlegging heeft gegeven op uw computer.

• NAME ON CALCULATOR (NAAM OP REKENMACHINE): selecteer de
achtergrondafbeelding (dit zou de standaardnaam moeten zijn, maar u
kunt de naam van de achtergrondafbeelding veranderen met dit menu).

• GRAPH AREA ONLY (ALLEEN GRAFIEKGEBIED): Selecteer in het
rechterpaneel of u alleen het grafiekgebied wilt verzenden of het hele
scherm. Als u een schermvastlegging terugzendt naar een rekenmachine,
kunt u het best alleen het grafiekgebied verzenden.

Een afbeelding bijsnijden

Een schermvastlegging van het grafiekgebied bevat het volledige scherm
van de TI-84 Plus CE, de statusbalk, de rand van de grafiek en het
grafiekgebied.

Met TI Connect™ CE-software kunt u de afbeelding bijsnijden tot het de
afmeting heeft van Graph Area Only (Alleen grafiekgebied) om een
Background Image Var (achtergrondafbeeldingsvariabele) te creëren. U
kunt een scherm bijsnijden naar Graph Area only in het dialoogvenster
Send to Calculators (Verzenden naar rekenmachines).
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• DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u
de afbeelding naar alle aangesloten rekenmachines wilt verzenden, of
alleen naar geselecteerde rekenmachines (in een keuzelijst).

Opmerking: schermvastleggingen en geconverteerde beeldbestanden
worden als Pic Vars (afbeeldingsvariabelen) verzonden naar zwart-wit-
rekenmachines.

Bestanden verzenden naar meerdere rekenmachines
1. Selecteer de toets Select Calculators (Rekenmachines selecteren) in het

dialoogvenster.

2. Plaats een vinkje in de vakjes naast de rekenmachines die u wilt
selecteren.

3. Klik op Send (Verzenden).

Vastgelegde schermen verslepen naar
computertoepassingen

Met de werkruimte Screen Capture kunt u vastgelegde schermen verslepen
naar tal van computertoepassingen en ze daarin neerzetten. Met deze functie
kunt u rekenmachineschermen gebruiken in uw documenten.

Schermen verslepen en neerzetten in computertoepassingen
1. Open het scherm of leg een scherm vast.

2. Sleep het scherm naar een geopende computersoftwaretoepassing voor
documenten of presentaties en zet het daar neer.



De werkruimte Calculator Explorer gebruiken

Met de werkruimte Calculator Explorer kunt u inhoud op uw rekenmachine
beheren.
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12 De werkruimte Calculator Explorer gebruiken

Onderdelen van het hoofdvenster van de Calculator
Explorer

Menubalk - Gebruik deze menu's om bestanden en afbeeldingen te beheren,
informatie over de rekenmachine te bekijken en om hulp te krijgen.

Opmerking: u kunt de meeste acties in deze menu's uitvoeren door items
vanuit het Inhoudspaneel te verslepen en neer te zetten.

Werkbalk - Klik op deze pictogrammen om bestanden toe te voegen, over te
zenden of te wissen van uw rekenmachine.

Inhoud toevoegen vanaf uw computer.

Geselecteerde inhoud verzenden naar uw computer.

Geselecteerde inhoud verzenden naar een andere aangesloten
rekenmachine.

Het geselecteerde bestand verwijderen.

De weergave van de inhoud van een aangesloten rekenmachine
vernieuwen.

Inhoudspaneel - Selecteer bestanden die u wilt beheren vanaf dit paneel.

Een aangesloten rekenmachine selecteren

Met de TI Connect™ CE-software kunt u meerdere rekenmachines tegelijk
aansluiten. Klik op de rekenmachine waarmee u wilt werken om deze te
selecteren. De geselecteerde rekenmachine wordt de standaardrekenmachine
voor alle acties van de TI Connect™ CE-software.



Voordat u begint
Sluit de rekenmachine aan op de computer en controleer of deze verschijnt in
het Inhoudspaneel.

Rekenmachinebestanden naar de computer kopiëren

U kunt de meeste gegevens, bestanden en programma's van uw
rekenmachine naar uw computer kopiëren als back-up van inhoud, om naar
anderen te verzenden of om rekenmachinegeheugen vrij te maken.

Een bestand van de rekenmachine naar de computer kopiëren
1. Klik op de naam van het bestand om het te selecteren.

2. Versleep en zet het bestand neer in een map op uw computer of op uw
bureaublad.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Een bestand van de computer naar de rekenmachine kopiëren
1. Navigeer naar het gewenste bestand op uw computer.

2. Sleep het bestand naar het paneel Lijst met rekenmachines en zet de
muis boven de gewenste rekenmachine.

3. Laat de muisknop los als u ziet.

4. Selecteer een bestandsnaam in het vervolgmenu. Dit wordt de naam van
het bestand op uw rekenmachine.

5. Klik op Send (Verzenden).

Bestanden verzenden naar aangesloten rekenmachines

U kunt bestanden verzenden naar rekenmachines die aangesloten zijn op de
TI Connect™ CE-software.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Bestanden naar aangesloten rekenmachines verzenden
1. Klik op de bestand(en) om deze te selecteren.

2. Klik op .
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• DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u
het bestand naar alle aangesloten rekenmachines wilt verzenden, of
alleen naar geselecteerde rekenmachines (in een keuzelijst).

Bestanden naar geselecteerde rekenmachines verzenden
1. Selecteer de toets Select Calculators (Rekenmachines selecteren) in het

dialoogvenster.

2. Plaats een vinkje in de vakjes naast de rekenmachines die u wilt
selecteren.

3. Klik op Send (Verzenden).

Achtergrondafbeeldingen converteren en verzenden

De TI-84 Plus CE kan achtergrondafbeeldingen en Pic Vars weergeven. Deze
variabelen wordt weergegeven in het grafiekgebied.



Opmerking: alle informatie over achtergrondafbeeldingen geldt ook voor de TI-
84 Plus C Silver Edition en de TI-83 Premium CE.

Werken met achtergrondafbeeldingen

De TI Connect™ CE-software converteert een afbeelding die u verzendt naar
een aangesloten rekenmachine automatisch in een
achtergrondafbeeldingsvariabele. Uw afbeelding kan anders worden
weergegeven in het grafiekgebied dan u verwacht, vanwege de conversie
naar de pixelafmetingen 83 x 133.

Opmerking: voor de beste resultaten kunt u uw afbeelding bewerken,
zodat deze in verhouding is met 83 x 133 pixels, voordat u de conversie
naar 83 x 133 pixels uitvoert.

De conversie naar de achtergrondafbeeldingsvariabele gebruikt 16-bits kleur.

U kunt ook een achtergrondafbeeldingsvariabele uploaden naar de TI-84 Plus
CE-emulatorweergave in de TI-SmartView™ CE-software..

Op de TI-84 Plus CE wordt een achtergrondafbeeldingsvariabele alleen als
achtergrond in het grafiekgebied weergegeven. Een achtergrondafbeelding
wordt geschaald weergegeven bij de MODE-scherminstellingen Full
(Volledig), Horizontal (Horizontaal) en Graph-Table (Grafiek-Tabel). Hierdoor
blijft eventuele wiskundige modellering die uitgevoerd is op een achtergrond,
bewaard. U kunt een achtergrondafbeelding niet bewerken terwijl u aan het
werken bent op de TI-84 Plus CE. Achtergrondafbeeldingen wordt uitgevoerd
vanaf en opgeslagen in het Archiefgeheugen.

De werkruimte Calculator Explorer gebruiken 15



16 De werkruimte Calculator Explorer gebruiken

Een achtergrondafbeelding verzenden naar een
aangesloten rekenmachine

U kunt een achtergrondafbeelding verzenden en deze weergegeven in het
grafiekgebied van de TI-84 Plus CE.

1. Open de TI Connect™ CE-software.

2. Kies de werkruimte Calculator Explorer.

3. Sluit de TI-84 Plus CE op de computer aan met de kabel.

4. Zet de TI-84 Plus CE aan.

5. Kies de afbeelding die u wilt converteren.

6. Sleep het plaatje naar het paneel Lijst met rekenmachines en zet de muis
boven de gewenste rekenmachine.

7. Laat de muisknop los als u ziet.

8. Selecteer een Image# naam uit het vervolgmenu (Image0 - Image9). Dit
wordt de naam van de afbeelding op de TI-84 Plus CE.

Opmerking: de naam van het Image#-bestand die u kiest wordt de naam
van de afbeelding op uw rekenmachine. Onthoud de naam van Image# (of
maakt deze onderdeel van de bestandsnaam op uw computer) om deze te
kunnen herkennen wanneer u dit bestand wilt verzenden of delen.

WAARSCHUWING: Voorgeladen afbeeldingen zijn opgeslagen in Image1 -
Image5. Gebruik een ander Image# om te voorkomen dat u de
voorgeladen afbeeldingen overschrijft.

9. Klik op Send (Verzenden).

• Geef het computerbestand een andere naam, zodat u uw Image Var later
kunt herkennen (brug, fontein enz.). De interne
rekenmachinevariabelenaam Image# wordt niet gewijzigd.



• Om de achtergrondafbeelding op te slaan op uw computer, sleept u het
Image# van de Calculator Explorer naar uw bureaublad of naar de map
waarin u het wilt opslaan.

• Om uw nieuwe achtergrondafbeelding weer te geven in het grafiekgebied
van de TI-84 Plus CE drukt u opy., verandert u de instelling
Background (Achtergrond) naar het Image# dat u zojuist naar de
rekenmachine heeft verzonden (bijvoorbeeld: Image5), en drukt u op
s.

Opmerking: Vanaf het grafiekscherm op de rekenmachine kunt u de
achtergrond ook veranderen met het interactieve commando [draw];
BACKGROUND; 1:BackgroundOn.

Rekenmachinebestanden wissen

U kunt gegevens, bestanden en programma's wissen van uw rekenmachine.

Bestanden wissen van de rekenmachine.
1. Klik op de naam van het bestand om het te selecteren.

2. Druk op .
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18 De werkruimte ProgramEditor gebruiken

De werkruimte Program Editor gebruiken

Met de werkruimte Program Editor kunt u werken met gegevensvariabelen.



Onderdelen van de werkruimte Program Editor

Menubalk - Gebruik deze menu's om bestanden en programma's te
beheren en hulp te krijgen.

Opmerking: u kunt de meeste van de acties in deze menu's
uitvoeren door items van het Inhoudspaneel te verslepen en neer
te zetten.

Werkbalk - Klik op deze pictogrammen om programma's toe te voegen,
te openen en op te slaan en om programma's naar uw rekenmachine
te verzenden.

Inhoudspaneel - Gebruik dit paneel om programma's te creëren, te
bekijken en te bewerken.

Cataloguspaneel - Gebruik dit paneel om uw rekenmachinetype te
selecteren en vervolgens uit lijsten te kiezen (op categorie) om

De werkruimte ProgramEditor gebruiken 19



20 De werkruimte ProgramEditor gebruiken

programma's te creëren.

Syntax-referentiepaneel - Gebruik dit paneel om de juiste syntax van
elk commando te bekijken, samen met de vereiste en optionele
argumenten.

Een nieuw programma maken

Als er geen programma's geopend zijn, dan geeft het Inhoudspaneel alleen de
pictogrammen New Program (Nieuw programma) en Open Porgram
(Programma openen) weer.

Een nieuw programma maken
▶ Klik op het pictogram New Program

(Nieuw programma).

Een bestaand programma openen
1. Klik op het pictogram Open Program

(Programma openen).

2. Navigeer naar de juiste map.



3. Klik op Open (Openen).

Een Var-naam bewerken

Namen van nieuwe programma's zien er als volgt uit: PROG##. De nummers
lopen op, bv.: PROG01, PROG02.

De naam van een programma veranderen
▶ Klik in het vakje Var Name en typ een nieuwe naam van maximaal 8 letters

of cijfers (het eerste teken mag geen cijfer zijn).

Uw programma beveiligen

Met de TI Connect™ CE-software kunt u uw programma beschermen tegen
bewerking nadat het programma naar een aangesloten rekenmachine is
verzonden.

Uw programma beveiligen

▶ Klik op het selectievakje naast het slotje.

Een programma opslaan op uw computer

Het sterretje aan het begin van de naam van een programma geeft aan dat het
programma niet is opgeslagen.

Een programma opslaan

1. Klik op .

2. Navigeer naar de juiste map.

3. Klik op Opslaan.

Een programma sluiten

Een programma sluiten
▶ Klik op de x naast de naam van het programma.
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Het Cataloguspaneel gebruiken

Het Cataloguspaneel bevat een lijst met rekenmachinecommando's, functies,
variabelen en symbolen die u kunt gebruiken om programma's te maken.

Een Catalogus-niveau uitvouwen of samenvouwen
▶ Klik op het driehoekje naast elk Catalogus-onderdeel.

Een Catalogus-onderdeel in het Inhoudspaneel plaatsen
▶ Sleep het Catalogus-onderdeel naar het Inhoudspaneel en zet het daar

neer.

-OF-

▶ Dubbelklik op het Catalogus-onderdeel.

Opmerking: door beide bovengenoemde acties wordt het Catalogus-onderdeel
achter de cursor geplaatst.



Opmerking: u kunt het best de catalogus met commando's en symbolen
gebruiken om deze in de editor te plakken om syntax-fouten, als gevolg van
onjuist gebruik van hoofdletters en kleine letters in commando's, te voorkomen.
(Bijv. nDeriv en niet Nderiv; Thick en niet thick)

Opmerking: de commando's worden pas omgezet in de
rekenmachinecommando's (tokens) als het programma naar de rekenmachine
is verzonden. Als er een fout is wanneer uw programma naar de rekenmachine
wordt verzonden of op de rekenmachine wordt uitgevoerd, controleer dan of
elk commando in de programmabewerkingsmodus van de rekenmachine ook
echt een commando-token is. Wanneer een commando een token op de
rekenmachine is, dan staat de cursor op het eerste teken en springt vervolgens
over het commando heen als een token. Als de cursor letter voor letter door
een commando beweegt, dan is dat commando niet omgezet! Verwijder en
plak het commando van de rekenmachine.

Opmerking: de taalinstelling van TI Connect™ CE bepaalt hoe de tekst
geïnterpreteerd wordt als een commando-token voor de rekenmachine. Het
openen van programma's en het terugzenden naar de rekenmachine met TI
Connect™ CE in verschillende talen kan resulteren in ongewenste commando-
tokens, die leiden tot syntax-fouten.

Het Syntax-referentiepaneel gebruiken

Het Syntax-referentiepaneel geeft de syntax van elk Catalogus-onderdeel
weer, met de vereiste en optionele argumenten.

Een programma verzenden naar een rekenmachine

U kunt een programma verzenden naar een aangesloten rekenmachine.

Een programma verzenden naar een aangesloten rekenmachine
1. Sla het programma op, als u dit nog niet gedaan heeft.

2. Klik op .

• FILE NAME (BESTANDSNAAM): Deze kan anders zijn dan de NAME ON
CALCULATOR (NAAM OP REKENMACHINE), afhankelijk van welke naam
u het programma heeft gegeven op uw computer.

• NAME ON CALCULATOR (NAAM OP REKENMACHINE): selecteer de
naam van het programma (dit zou de standaardnaam moeten zijn, maar u
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kunt de naam van het programma veranderen door op Custom
(Aangepast) te klikken.

• LOCATION (LOCATIE): Kies of u het programma wilt opslaan in het RAM of
in het archief van de rekenmachine.

• DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u
het programma naar alle aangesloten rekenmachines wilt verzenden, of
alleen naar geselecteerde rekenmachines (in een keuzelijst).

Programma's verzenden naar meerdere rekenmachines
1. Selecteer de toets Select Calculators (Rekenmachines selecteren) in het

dialoogvenster.

2. Plaats een vinkje in de vakjes naast de rekenmachines die u wilt
selecteren.

3. Klik op Send (Verzenden).

Taalinstellingen
Als u een TI-Basic programma in een andere taal wilt ontwikkelen dan in de
ingestelde taal van het besturingssysteem van uw computer, dan kunt u TI
Connect™ CE opnieuw starten in een andere taal.

1. Selecteer File > Change Language (Bestand > Taal wijzigen).

2. Selecteer de taalverandering na het opnieuw starten van de toepassing.



• QUIT LATER (LATER AFSLUITEN) - Bewaart de geselecteerde taal; TI
Connect™ CE start in deze geselecteerde taal de volgende keer dat TI
Connect™ CE wordt gestart.

• QUIT NOW (NU AFSLUITEN) - Start TI Connect™ CE opnieuw in de
geselecteerde taal.

• CANCEL (ANNULEREN) - De taal wordt niet gewijzigd. De taal van het
besturingssysteem van de computer is de standaardtaal.
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Uw rekenmachine onderhouden

Het besturingssysteem van uw rekenmachine updaten

Met de TI Connect™ CE-software kunt u besturingssystemen voor grafische
rekenmachines downloaden.

Voordat u begint
• Maak een back-up van uw rekenmachinebestanden (RAM, Archief en

Apps).

• Zorg ervoor dat uw rekenmachine aanstaat en goed is aangesloten op de
computer.

• Als u meerdere rekenmachines heeft aangesloten met USB-
computerkabels, haal deze dan allemaal los, behalve de rekenmachine
die u wilt updaten.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Besturingssystemen van grafische rekenmachines updaten
1. Klik op Actions > Send OS (Acties > OS verzenden).

2. Navigeer naar het juiste OS-bestand voor uw model rekenmachine dat
opgeslagen is op uw computer.

3. Klik op Open (Openen).

Informatie over de rekenmachine krijgen

Met TI Connect™ CE-software kunt u informatie over uw rekenmachinetype,
product-ID, OS-versie, RAM, archief, taal, ROM-versie en hardwareversie
krijgen.

Informatie over de rekenmachine bekijken
▶ Klik op View > Calculator Information (Bekijken > Rekenmachine-

informatie).



Compatibiliteit met grafische rekenmachines

Raadpleeg de TI-84 Plus CE Starthandleiding voor informatie over
compatibiliteit met grafische rekenmachines. Zie ook de TI-83 Premium CE
Starthandleiding.

Opmerking: in het algemeen zijn bestanden van TI-84 Plus CE grafische
rekenmachines compatibel met andere TI-84 Plus- en TI-83 Plus-modellen.

Apps, besturingssytemen en bepaalde gegevensbestanden met niet-
ondersteunde numerieke typen kunnen niet gedeeld worden tussen modellen.

TI-Basic programma's moeten mogelijk aangepast worden om correct
weergegeven te kunnen worden op modellen met kleurenschermen met een
hoge resolutie.
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Algemene Informatie

Texas Instruments Ondersteuning en Service

Startpagina: education.ti.com

Vragen per e-mail: ti-cares@ti.com

Kennisbank en vragen per e-mail: education.ti.com/ondersteuning

Internationale informatie education.ti.com/internationaal

Service- en garantie-informatie

Zie voor informatie over de duur en de voorwaarden van de garantie of over
productservice het garantiecertificaat bij dit product, of neem contact op met uw
plaatselijke Texas Instruments-leverancier/-distributeur

http://education.ti.com/
mailto:ti-cares@ti.com
http://education.ti.com/support
http://education.ti.com/international
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